
Business Management '99
Getting Started

First Time Setup Wizard
Salesperson Logins

Business Management 99 Configuration
Company Information
Program Configuration

Creating Invoices
Invoice Wizard
Change Salesperson

Database Managment
Customers
Inventory
Suppliers
Sorting Databases
Backup & Restore

Accounting
Accounting Wizard
Record Purchases
Activate Journals

About Business Management 99
Registration
The Authors
Our Website



Business Management 99 was designed and coded by Jim Semple & Chris Kowalski.



Download newer versions of our program at (http://www.circuitz.com/).
We plan on posting program updates, frequently asked questions, developer resources, known bugs, 
helpful tips, contacts and other useful information at the site.



Sorting customers, inventory, and suppliers does a shell sort on the selected database, which organizes 
the database in order by account number.



Compact & Backup Databases takes each file and writes a new binary file in the BACKUP directory. (eg. 
CUSTOMER.BAK) The Extract & Restore Databases command expands all of the backup files from 
within the BACKUP directory to the regular DATA directory. Before restoring you are prompted that it will 
overwrite any existing databases, so be careful. These two features are useful during year ending 
adjustments and several other times of the fiscal year. If an invoice is processed incorrectly or a customer
was deleted by mistake these can come in handy. Make them a frequent task during the day. When 
restoring you must re-enter any data that occurred after the most recent backup.



When keeping track of sales for specific salespersons (possibly for commission and/or referencing 
policies) you can change the current salesperson which will appear in any menus, databases, invoices, 
etc. Use the Change Salesperson command from the File menu, which prompts for a new login and 
password. The Administrator or a user with access privileges to Add/Delete salespersons, can use the 
Salesperson Logins database from the Edit menu. Users and access privileges to specific parts of the 
program can be created and modified here. When starting out with Business Management 99 for the first 
time, by default the Administrator login is used with no password. The default for Login & Data Security is 
disabled as well.



Before activating the journals you should check to make sure that you have forwarded all previous 
balances into the Accounts section, which can be found in the Edit menu. You are then ready to activate 
the journals and begin with the fiscal period you have specified. At the end of the fiscal period you should 
make year ending adjustments to account for lost and/or damaged inventory, record depreciation and 
other adjusting expenses, then to print out financial statements. After which you will be prompted to reset 
the invoice number and closing entries will be made. Archival of the previous years ledger and past 
invoice databases will be done and the accounting journals will be deactivated for use. You may then 
setup dates and accounts again for the next fiscal year.



Invoice Wizard
Sales Invoice

Sales invoices are the most widely used Invoices in business. In general a Sales invoice charges both 
taxes (if applicable) to the end-customer. Sales invoices generally are used for selling inventory 
merchandise. The default payment is Cash/Cheque from the end-customer. Repeat customers found in 
the Customers database can be loaded onto the invoice using the Search command, this loads up the 
Customers database for retrieval of a customer. This allows the option of Account Charge as a method 
of payment as well. 
TIP: Customers can be loaded using an appropriate Shortcut from the Customer Name textbox. The 
Search By combo is used as the search index. (eg. Account Number, Customer Name, Phone Number 
are all fields which can be searched from within the Customer Name textbox) When finished try the 
Check Name checkmark to load up a matching customer.

Services Invoice
Service invoices are used when a customer wishes a service to be performed where the default of 
Federal Tax only is charged. In the case of the US where no taxes are applied to services in most 
States, you may adjust taxes from the Invoices tab in Configuration. Configuration can be found in both 
the main menu and the Edit menu.
TIP: You can save commonly performed services in the Inventory database with a Stock Code 
reference, then these Inventory items can be loaded up by the Invoice or many other forms instantly with
the matching price and associations.

Credit Invoice
Credit invoices will appear visually the same as a Sales invoice, but behind the scenes the customers 
account information is being updated and the appropriate Accounting transactions are being performed 
when processed.

Estimate Invoice
Use this option to quickly search out items with matching prices for a customer quote. The default 
invoice number for Estimate invoices is N/A and the invoice number counter is NOT incremented. The 
invoice is however saved in the Past Invoices database for later retrieval. You can find past invoices 
using the Invoice Wizards View Past Invoices command.
TIP: When using the invoice form you can choose Load Invoice which will load Past Invoices existing in 
the database. This is useful for loading up a past quote and processing it as a regular invoice.

Miscellaneous/Sundry Sales
When items being purchased are less important than regular Inventory items, they may be omitted from 
the Inventory database. Miscellaneous/Sundry Sales by default processes the invoice with no Federal or
Vendor sales taxes. This option can be changed from the Invoices tab in Configuration. Configuration 
can be found in both the main menu and the Edit menu.
The proper use for this invoice is undefined but in general used for damaged goods, used items being 
liquidated for cash, small less important Inventory items and/or items very cheap in price.

View Past Invoices
Each invoice that is processed with be saved in the Past Invoices database. Simply choose the View 
Past Invoices option from the Invoice Wizard or Load Invoice from the invoice form. 
View Past Invoices comes in handy for reprinting lost invoices. It may also be used for creating 
additional Sales, Customer, Accounting, and/or Shipping copies.
TIP: The Past Invoices database (PAST.DAT located in the DATA directory) is expected to get quite huge
if you are processing massive quantities of invoices. If you find that the file is getting too large and the 
seeking of invoices is taking way too long you may wish to backup all databases and remove the 



PAST.DAT file from your system. (eg. Windows Explorer can be used to delete it from your file system)



Inventory
Stock Code

Inventory Stock Code is used for the primary key of the Inventory database. Stock Code numbers can 
be used to quickly load an item onto invoices as well. In the Description (Shortcut) field you can type the 
appropriate Stock Code for an Inventory item (not case sensitive) and the Inventory item with its 
associated price will come show up automatically.

Description
The item description in the inventory editor can be one of a few things; it can be an item currently in 
inventory, a service that is frequently performed, or something such a comment often used on invoices 
like 2 Years Parts & Labour Warranty or something of that nature.

Quantity
The quantity section of the Inventory database is quite simple. The current stock quantity is displayed in 
the database and when an invoice is processed the stock quantity of an Inventory item are 
decreased/increased accordingly. You may change the Track Inventory option in Configuration in order 
to monitor quantities when Invoices and Purchases are processed. Specify a minimum and maximum 
amount for the current Inventory item and you will be notified when an Inventory item is getting low in 
quantity and to order more. (This is activated or deactivated by the Show Minimum Warning option of 
Configuration)

Wholesale & Selling Price
Wholesale prices come from the Inventory items current Supplier. The items appropriate Supplier and 
Supplier Code fields can be stored for the current Inventory item. The default tax charged on Wholesale 
purchases can be changed from Company Information in the Edit menu.
See Markup Percentage for further details on the updating of the Selling Price field…
When changing the Wholesale price of an item, the Wholesale Price including tax is updated. Along with
the Wholesale Price, the Selling Price is calculated from the taxed Wholesale Price and the Markup for 
current item. The Selling Price including tax is an additional field for your viewing pleasure. When 
looking through inventory you sometimes would like to give an exact price to the end-customer instead 
of going through the process of loading up a brand new invoice in order to maintain a total including 
taxes.

Markup Percentage
Each inventory maintains an individual markup percentage for its selling price. The default markup 
percentage is used when first adding an inventory item to the database. The default markup percentage 
can be accessed from Company Information in the Edit menu. To change the current markup for an 
Inventory item simply click on the Change Markup button.

Associations
Associations are used for grouping items in inventory together. (eg. CPUs & Motherboards, Cars, Office 
Supplies, Toys, Books, etc.) The Inventory Statistics section requires Associations to be run, which is 
used to manage the Inventory database.

Inventory Statistics
Inventory Statistics is a useful tool that can be used for managing the Inventory database. There are 
options for printing out either one Inventory Association at a time or for printing all Inventory Associations
at once. In Inventory Statistics you can view which items are currently low in quantity and the suggested 
quantity to order is calculated from the Inventory database.
Printing Inventory Statistics sends the items current Association, Stock Code, Description, Selling Price, 
Quantity, Minimum Quantity and Suggested Quantity to the printer.





Customers
Account Number

When assigning a customers account number, the Next Available Account Number is there as an option.
The customers account number must be unique (primary key). The account number for a customer can 
be used to load up customer information on invoices as well.

Customer Name
When naming a customer in the customer database you also have the option of loading all of the 
customer information onto invoices with this field as a shortcut.

Phone Number
You can use the customers phone number as a shortcut for loading their information onto an invoice, 
many business use this as the preferred method, since a lot of customers never actually remember their 
account number. The length allowed for a phone number is 14 characters. This will generally cover 
phone number conventions like:
555-5555
(555) 555-5555
1-555-555-5555

Vendor Tax Exempt
This field was intended for Suppliers, whom have many customers that purchase goods paying only 
Federal Tax to the supplier. A Vendor Permit ID is always required by the customer. For example, in 
Canada, Distributors and Value Added Resellers (VAR) are able to purchase merchandise from 
Suppliers without paying Provincial Sales Tax (PST).

See Suppliers in the main menu of help for similar fields that are used in both the Suppliers database 
and the Customers database.



Suppliers
Address Information

Complete the supplier name, address, city, province/state, postal/zip code, country, phone number, fax 
number fields with regards to shipping and receiving for this supplier.

Maintain Contacts
Use the provided contact name field to fill in the name of the person responsible for the sales 
department, the service desk or something similar. You can also specify a phone number and extension 
number to reach this contact in the company phone number field.

Internet
Keep track of websites as well as your login and password to the sites secure online order entry 
system? Email is also becoming an increased method of information transfer as well.

See Customers in the main menu of help for similar fields that are used in both the Customers database 
and the Suppliers database.



Accounting Wizard
Recording Transactions

Business is all about transactions. When a financial change occurs in your business a transaction must 
have occurred as well. To enter these transactions in go to the appropriate journal; then enter the date, 
details of the transaction, and the source document number. When you are working with an account just 
enter the input amount in the money area then choose if the transaction made was a debit (DR) or credit
(CR) to the account. The accounts loaded into the Journals can be modified from the Accounts database
in the Edit menu.

Sales Journal
Sales invoices processed from the Invoice Wizard are automatically posted to the sales journal. The 
sales journal can still be used to record hand written invoices or invoices from a separate invoicing 
program. Be sure to record any discounts allowed along with the invoice posting.
Accounts:
      GST Payable (CR)
      PST Payable (CR)
      Sales Revenue (CR)
      Accounts Receivable (DR)
      Discounts Allowed (DR)
      Other Accounts (CR)

Cash Receipts Journal
Cash receipts, cash register tapes, bank credit memos, and any other receivables source documents 
should be recorded in the cash receipts journal. Be sure to record discounts allowed.
Accounts:
      GST Payable (CR)
      PST Payable (CR)
      Sales Revenue (CR)
      Accounts Receivable (DR)
      Bank (DR)
      Other Accounts (CR)

Purchases Journal
Invoices and credit invoices issued by your supplier should be recorded in the purchases journal. Be 
sure to record any freight-in charges, and any discounts earned.
Accounts:
      GST Recoverable (DR)
      Supplies (DR)
      Purchases (DR)
      Accounts Payable (CR)
      Miscellaneous Expense (DR)
      Other Accounts (CR)

Cash Payments Journal
Cheque copies, bank debit memos and other payables source documents are the main form of entry in 
the cash payments journal. Record any freight charges, and discounts earned as well.
Accounts:
      GST Recoverable (DR)



      Purchases (DR)
      Accounts Payable (DR)
      Bank (CR)
      Wages Expense (DR)
      Other Accounts (CR)

General Journal
Any transactions that cannot be recorded in any of the other journals successfully, you can use the 
General Journal to post them. Owners drawings, Miscellaneous Sales, Operating costs, etc. can all be 
recorded here.

Year Ending Adjustments
Year ending adjustments are performed to adjust year ending inventory, finalized operational costs like; 
depreciation of equipment, furniture & fixtures, automobiles, and buildings, supplies used, and any 
prepaid expenses. After the financial statements are displayed, income and expense accounts are 
cleared out and all of the accounts are closed off. (The current balance of each account is forwarded to 
the opening balance of the account.) The old Ledger and Past Invoices databases are archived and you 
have the option of resetting the invoice number to 1 again for the upcoming year. The journals are then 
deactivated for use. You may then change fiscal period dates and reactivate the journals for use again to
start a new fiscal year.
TIP: You are strongly recommended to backup any data before continuing with this procedure!



Configuration
General tab

You can change the values for Customer Accounts and Supplier Accounts payment terms. Payment 
terms will be supported in future versions with the Accounts Receivable and Accounts Payable 
Subsidiary Ledgers. These will list all overdue accounts, the discounts being offered, total prices, 
interest charged, etc.
Printing options simply consist of the number of copies to be printed for Invoices or Past Invoices. On 
the invoice form, select Print Invoice to checked and then choose OK. As for the Past Invoices database 
as well, select Reprint Invoice to checked and then choose OK and a new reprinted copy will be fired off 
to the printer.

Logo tab
If you have the box checked to display your business logo you will be prompted to find the image from 
your hard disk. You will then see the image in the preview box. The ideal size for you business logo to fit 
in the preview box is 180 x 60 pixels. If you see an error message under the preview box then you have 
either moved or misplaced your business logo graphic on your hard drive. If this happens just uncheck 
the display business logo box and then check it again to find where your graphic is placed.

Inventory tab
Inventory Rounding allows you to choose the default two ending decimal places to an inventory item 
when the Selling Price is calculated in the Inventory database.
Track Inventory Quantities does the addition and subtraction of quantities when invoices are processed. 
Some business may use other methods of keeping inventory therefore they can disable this nice feature.
When Show Minimum Reached Warning is checked you will be prompted when an Inventory item is low 
that is being loaded onto the invoice, this occurs when you choose Add Item. A message box will be 
displayed giving you a suggested order because you are low in stock on that particular Inventory item.

Accounting tab
Fiscal Start Date, Fiscal End Date and Current Using Date can be modified in the Accounting section of 
Configuration. The Current Using Date is loaded into all Journals for new journal entry posting. You must
modify this date in the Configuration in order to Post entries from another day. 
If available, you can Activate Journals for use. See Activate Journals in the main menu of help for more 
details on what this function does.

Invoices tab
In this configuration, you have the option of adding/omitting any taxes to invoices. (The default taxes for 
an invoice refers to those in Ontario, Canada.)
The current invoice number is displayed on all invoices. You can change this to reflect your old invoice 
records or start at the default of 1, when converting over to Business Management 99 and using it for 
the first time.



Salesperson Logins
Administrative Login & Password

The administrative login and password by default is Administrator for the user name and no password. 
This security feature ensures that no users gain access to information you dont want them to get at. 
Only the Administrator can change this password (they must be currently logged in). When first starting 
out the Administrator can assign access privileges to various parts of the program to different users. This
comes in handy on a system based with more than 1 concurrent user. You may choose the various 
options in the Password Prompt section of this database to prompt the user to enter an administrative 
password if they do not normally have access to the program feature/function/database.
TIP: Some businesses would prefer to change the Administrator name to Sales or something similar to 
be view on all invoices.

Login & Data Security
When you have Login & Data Security disabled you will not be prompted for passwords when you are 
first logging on to Business Management 99 or anytime within the program. By default the Administrator 
is the default login and Login & Data Security is disabled.

Administrative Options
If you are logged in as the administrator you can do anything within the program without being prompted
for the administrative password. Other users however, will see the enter administrative password screen
show up every time they are accessing something important that they can not normally access without 
the password you have set.

Salesperson Options
If you are logged in as a regular salesperson you may be prompted for the administrative password if 
you are trying to access something in the program that the administrator would not like you to normally 
be using. The various options and databases accessible to you depends on the checked areas for your 
username in the Security section of Salesperson Logins.
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This import feature allows you to bring in an existing database from an external programs database. The 
supported file format is a Comma Separated Values (CSV) file, which can be exported by either Access or
Excel. You must follow the proper data organization for the import to work properly. See the template files 
that are distributed with the setup package.



When starting a new fiscal period with Business Management 99 for the first time, this feature comes in 
handy to forward account balances into each account, then use the Accounts editor found in the Edit 
menu to finalize any changes. The journals may then be activated for use.



Record Purchases
Supplier Name

Any supplier in the suppliers database can be accessed by the supplier shortcut field by typing in which 
supplier from which you have purchased the goods, otherwise the field is changed to Anonymous 
Supplier if you have not specified a name for the supplier.

Phone Number
When a supplier is found the phone number field is changed automatically, and is disabled because the 
change of this field is not necessary. When specifying any other supplier not in the database the phone 
number field is changed to None automatically.

Invoice Number
An invoice number is crucial for the source document field in the Purchases and Cash Payments 
journals. If the invoice number field is labeled Cash then the journal entry is placed in the Cash 
Payments Journal, meaning that your bank account is affected right away by this transaction. The 
invoice number field should be labeled with the invoice number of your normal suppliers invoices that 
you have paid by cheque or charged the purchase to account. This purchase will not directly affect the 
Bank account therefore the entry is placed in the Purchases Journal.

See Inventory in the main menu of help for more details on what you should enter into this form.



This information is displayed on all invoices and financial statement printouts. When choosing a country 
the appropriate taxes headers and labels are loaded for you as well. Your Federal ID refers to GST in 
Canada and State Tax in the United States. The Vendor ID refers to rights to sell goods in Canada with 
PST while not paying any PST from your wholesaler, in the United States there are Local Taxes applied 
for certain areas, select if necessary. This wholesale tax for Canada is generally 7% using the current 
GST rate. In the United States most manufacturers do not charge taxes on wholesale items therefore this 
field can be set to 0%. You must also set a default tax percentage for markup on Inventory items. Once an
Inventory item is added the markup for the current item can be changed, but this field serves as a general
markup for your business on a larger scope.



Registration
In order to get the full company information to be displayed on all invoices and financial statement 
printouts, you will need to register. Notice that the company name area is disabled. You thought you 
could just ignore the annoying screens and get away from not registering? :-) 

If this area says REGISTER! (Your Company Name Here) you must follow the license agreement (see 
license.txt in the DATA directory) and agree to the terms listed before sending for your registration key. 
Once we receive a check or money order we will immediately send your registration key through e-mail 
and send the invoice accordingly. Credit card payment is not yet available but will be available in the 
future.

Prices for Registration are:
1 Home Workstation registered to a users name (eg. User: Jim Semple, Company: Jim Semple) for 
simple reports at home. This comes to $23 Canadian including GST & PST.
1 Business Workstation can be registered to single user on a network. You must register again for 
each additional workstation user that wishes have the program. (see license.txt in the DATA directory). 
The price is easily affordable for any business at $69 Canadian including the standard GST & PST sales
taxes.

    Our Federal Tax ID #876721564

When you have registered the nag screens disappear and you can print out professional looking 
invoices and reports with Business Management 99.

Thanks for supporting our efforts to bring you easy-to-use, quality software! We look forward to making 
and bringing Business Management 2000 to you for next Christmas!






